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RiverWISE Stakeholder Guide
RiverWISE (RiverWare Interactive Scenario Explorer) is a stand-alone application for viewing and 
exploring alternatives of certain specially configured models generated in the RiverWare software. 
RiverWISE is freely available and easy to use – it does not require the RiverWare software or training. 
RiverWare model developers build a river system model, develop a baseline scenario, and select 
important input variables that could reasonably be modified in exploring alternative scenarios. They 
select key output variables of interest for comparing alternatives. Using a utility in RiverWare, they 
create and export a special file, a WISE file (*.wise) that can be opened in RiverWISE. 
Stakeholders, i.e., anyone interested in seeing results of the RiverWare model and exploring alternative 
scenarios, use RiverWISE to open the *.wise file, view results, change values of the designated input 
variables, execute the simulation and compare resulting output values. They may create several 
scenarios, save them and send them to others. 

1. Install and Run RiverWISE

If you already have an active RiverWare license, RiverWISE is included; a separate RiverWISE license 
is not needed. To execute RiverWISE, use the Windows Start menu to navigate to All Programs  
CADSWES  RiverWISE X.X.X

If you do not have an active RiverWare license:
1. Download and install RiverWISE following instructions on the RiverWare.org website. You will 
need to install the same version that was used to generate the WISE file, so you will need to know the 
version number.

2. Obtain and install a RiverWISE license from CADSWES. See instructions at RiverWare.org.

3. Execute RiverWISE by clicking on the desktop icon. 

4. An empty RiverWISE window should open.

2. Open a WISE File

Obtain a WISE (*.wise) file from a RiverWare model developer or other RiverWISE user. 
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Open a WISE file using the menu File  Open WISE File. Navigate to the location of the *.wise file 
that you wish to open, then click the “Open” button.
If large, WISE files might take several minutes to load. A status message at the bottom left of the dialog 
will note the time the loading began, e.g., “Open WISE File Started at 11-08-2017 10:23:18”. While 
loading, the cursor will be displayed as an animated circle; when loading is complete, the status 
message will be updated to reflect the new status.
After opening a WISE file, the RiverWISE window should look something like this figure with menus at 
the top and tabs for various displays and functions. The WISE file opens to the RiverWare Model and 
Scenarios tab that shows a textual description of the model/run (if one is provided by the model 
developer), a schematic of the river system and scenario information. The original *.wise file name 
(when exported from RiverWare) and the simulation time period are shown.

TabsMenus

Status bar
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Note: The file name consists of a root, the date when the wise file was exported by the 
developer, a tag if saved from RiverWISE, and the .wise extension. The convention is 
FileNameRoot.ExportDate.wise. For example: MightyBuffalo.2018JAN03180023.wise. 
The *.wise file you opened might also have a tag before the *.wise. The tag is not present in 
the original file name, as created by RiverWare. The file name and export date persist in the 
file name through subsequent saves of the wise file and when exporting scenarios. This 
allows you to associate your saved WISE files and scenario files with the original WISE file. 
For more information on saving and exporting, see HERE (Save WISE File and Export Scenarios).

3. View the RiverWare Model Schematic

The model schematic shows the model components (objects and links) that form the network of the 
RiverWare hydrologic model. The various Object types are listed in the table below. Links represent 
data connections between data on the Objects. An image, e.g., map, may be displayed with the 
schematic. 
Navigate the model schematic using the following:
• Zoom in or out: right-click within the display panel and select the desired zoom level. 
• Pan: Use the middle mouse button and Scroll bars to pan through the schematic.
• View links: hover over the lines on the workspace to see tooltips describing the links.
• Click “Open in Separate Window” button to show the schematic in a separate display. This allows it to 

be visible even when another RiverWISE tab is selected.

TABLE 1.RiverWare’s Object Types
Storage Reservoir
Reservoir with Release and spillways; no hydro-
power. Pool Elevation is a function of Storage.

Level Power Reservoir
Reservoir with hydropower (turbine release) and 
spillways; Pool Elevation is a function of Storage.

Slope Power Reservoir
Reservoir with hydropower and spillways. Storage 
is level storage plus wedge storage.

Pumped Storage Reservoir
Reservoir with reversible pump-turbines that may 
generate or pump at each timestep.

Reach
Models routing in a river section; acts as node for 
diversions and return flows; models gains, losses.

Groundwater
Models head based flow and storage of water in 
ground, groundwater-surface water interaction.

Aggregate Reach
Aggregation of multiple Reach objects.

Stream Gage
Represents a gauge location in a river system; no 
simulated process.

Confluence
A flow junction with two Inflows and a single Out-
flow.

Pipeline
Models pipe flow (pressurized).

Bifurcation
A flow junction with two Outflows and a single 
Inflow.

Pipe Junction
Models a junction in pressurized flow system .
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4. Manage the Scenario List

A scenario in RiverWISE consists of a set of input values along with the results computed by a 
RiverWare simulation. When a *.wise file is exported from RiverWare, it contains a single scenario, the 
baseline scenario, representing the input/results for the original simulation, as conducted by the model 
developer. RiverWISE users (stakeholders) may create new scenarios, receive scenarios from other 
stakeholders, and export their scenarios to others.
The Scenarios panel in the lower portion of the “RiverWare Model and Scenarios” tab displays the list 
of scenarios currently in this WISE file and has controls to re-order the scenarios in the list, delete and 
create new scenarios.
The list has 3 columns:
• Name: short text identifying the scenario; the name is assigned when the scenario is created or 

imported. Each name must be unique in the list
• Last executed: the completion date/time for the last execution of the scenario. This is empty if the sce-

nario has not been executed.

Water User
Diverts water from a Reach or Reservoir, models 
consumptive use and return flows.

Inline Pump
Models a booster pump station; calculates added 
head and power consumed.

Aggregate Diversion Site
Contains Water Users; diverts from Reach or Res-
ervoir; models consumptive user and return flow.

Inline Powerplant
Models power generation in reach with no storage, 
also called run-of-river power plant.

Diversion
Diverts water from a Reservoir or Reach.

Power Plant Diversion
Models the diversion and consumption of water by 
a Power Plant, often for cooling.

Canal
Models bi-directional conveyance channel by grav-
ity flow between two reservoirs.

Thermal
Models economics of thermal power system and 
thermal replacement value of hydropower.

Aggregate Distribution Canal
Routes flows through multiple canal reaches from 
Diversion to Water users, and routes demands

Data Object
Container for user-configured data and custom 
slots e.g. expressions for user-defined calculations.

Control Point
Point of regulation e.g. for channel capacity for 
floods or instream flow regulation.
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• Description: an optional and editable textual description of the scenario.

To edit a description, select the scenario in the list, then click the Edit Description button. Edit the text 
in the description field.

Note: [Tip] Useful information to add to the comment includes the name of the scenario that 
this scenario is based on, user who created the scenario, changes made to input data, and 
comments on the results.

The baseline scenario, indicated by an asterisk is defined by the model developer and cannot be edited.
Create a new scenario: enter a name into the Name field of the Create New Scenario box, then select 
one of the currently listed scenarios on which to base the input values of the new scenario. When the 
new scenario is created, its input values will be identical to those of this scenario. Click the Create 
button to have the new scenario appear in the list. 

To modify the inputs of your new scenario and execute a simulation to compute results, select the Edit 
and Run Scenarios tab.
Import Scenarios: One or more scenarios based on the same RiverWare model and baseline scenario, 
created in RiverWISE and exported to a *.sce file can be imported into the list. From the File menu, 
select Import Scenarios. You are first prompted for the path of the *.sce file to be imported, and then the 
import occurs. The new scenarios are appended to the list. Imported scenarios are renamed as necessary 
to ensure that all scenario names are unique within the currently open WISE file list.
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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5. Edit and Run Scenarios

To edit input data and run the scenarios, click on the Edit and Run Scenarios tab. Here you can 
activate a scenario, view and change the input data, compare the inputs with the inputs of other 
scenarios, and execute a simulation of the scenario to compute the results for the modified inputs.

Active
Scenario

Selected
Data Set

Plots

Tables

Run
controls

Scenario

View

Controls

Controls
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First select the active scenario, i.e. the non-baseline scenario you wish to edit and simulate, by clicking 
on the menu button labeled “Scenario” and select the desired scenario from the drop-down list. (You 
can create new scenarios on the Scenarios panel on the lower portion of the “RiverWare Model and 
Scenarios” tab.)

5.1 Select Data Set to Modify

The Input Data Sets panel lists the active scenario's input data that can be modified from the baseline 
run. The columns of the list provide the following information for each data set:

• Location: The basin location of the data.
• Name: The name of the modeled quantity; it can be physical data (e.g., “Inflow”) or water accounting 

data (e.g., “Storage in the M&N Account”).
• Modification from Baseline: Whether or not the data in the data set for the selected scenario differs 

from the data in the baseline: “None” indicates that no modification from the baseline values has been 
made; “Edited” indicates that one or more values have been changed.

• Data Type: the form of the numeric data associated with the data set. There are the following possibil-
ities: 
- Series – a time series of values; 
- Table – a matrix of values; 
- Scalar – a single value.

• Minimum and Maximum: the minimum and maximum values permitted for the data set. These are 
optionally established by the developer for Scalar and Series data.

Note that all of the scenarios contain the same list of Input Data Sets. Values within those data sets may 
vary between scenarios. These variable are a subset of the models input, selected by the developer, and 
common to all scenarios for a given WISE file.

5.2 Modify a Data Set

To change the values for an input data set, select that data set in the Input Data Sets list. Then, controls 
for modifying value(s) are displayed below the Input Data Sets list. These controls vary according to 
the data type: Series, Scalar or Tables.
The edit panel displays values for all displayed scenarios to allow comparison of input values, but only 
the values for the currently active scenario can be changed,  On the “Scenarios to Show” panel to the 
right of the data display, select which scenarios’ data to display and the display color associated with 
each.
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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5.2.1 Modify Series Data

When a series data set is selected in the Input Data Sets list, the edit controls consist of a plot and a 
table of values. The plot shows the data associated with the data set, with each scenario’s data plotted 
using its color. 
Either the plot or the table can be hidden by deselecting the appropriate check box to the lower right of 
the panel.
The table of values has one row for each date in the series, listed on the left, and one column for each 
scenario. The columns have a label (may be created by model developer) and the units of the values. 
(The color of the label corresponds to the color of the scenario associated with that column).
Only values for the active scenario can be edited, and of those, only those that were provided as inputs 
to the original RiverWare model run can be edited. That is, if the series value for a particular date was 
computed by RiverWare and not originally input by the model developer, then it is not editable. Non 
editable values show cross-hatching and cannot be changed. 

To enter a value into one or more cells of the table, first select the cells you would like to change, type 
in the number, and then hit return. 
To learn how to enter values into multiple cells and to copy/paste from/to other applications such as 
Excel, see HERE (Section 5.3).
For more information on plotting, see HERE (Section 9).

Read-only crosshatching

Editable Data
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5.2.2 Modify Table Data

When a table data set is selected, the edit panel displays a table of values. The rows are indexed and 
may also have a text label. The color-coded columns, one for each scenario, show units and possibly a 
title. Only values in columns associated with the active scenario can be edited. .

Note: Two-column tables also show a plot, when possible. Other tables only show only data.

To learn how to change values in multiple cells and to copy/paste from/to other applications such as 
Excel, see HERE (Section 5.3).
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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5.2.3 Modify a Scalar

When a scalar data set is selected, the edit panel displays an editable value and possibly a slider. 

To change the value either enter a new value into the Value box or drag the slider to the desired value. 
The Minimum and Maximum values configured by the Model Developer are also shown. They define 
the limits of the slider. 

5.3 Edit Operations and Copy to/from Excel

Values that are read-only are displayed with a light 
gray crosshatching. Note that only one tab supports 
editing of values, the “Edit and Run Scenarios” 
tab. 
To enter a value into one or more cells of the 
table, first select the cells you would like to change, 
type in the number, and then hit return.
You can also select one or more cells and copy and 
paste from or to another application (e.g. Excel). A 
common work flow involving Excel is: 
• Highlight a range of cells. 
• Right click and choose Copy

• Go to Excel and paste the data into a range of 
cells. 

• Edit the data in Excel using formulas and other techniques. 
• Copy the desired cells in Excel.
• In the RiverWISE “Edit and Run Scenarios” tab, highlight a range of cells and right click. 
• Choose Paste to bring in the data.
Copy data to Excel or other application. To display or analyze simulation results in Excel or other 
tools, copy data from RiverWISE and paste it into another application. 
Within the RiverWISE “Edit and Run Scenarios” or “View Results” tab:

Read-only crosshatching

Editable Data
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• Highlight a range of cells or entire columns of data. 
• Right click and choose Copy

• Go to Excel or another application and paste the data into a range of cells. 
Paste data from Excel or other application. To import data from other tools, copy the data and paste 
it into the Edit and Run Scenario tab in RiverWISE. 
• For example, in Excel, highlight a range of cells, i.e. a column of data. 
• Right click and choose Copy

• Within the RiverWISE “Edit and Run Scenarios” tab, highlight the desired cells. Only the currently 
selected scenario is editable and will not have cross-hatching.

• Right click and choose paste.

5.4 Execute a Scenario

After modifying input values, execute the scenario to generate the new results. Click on the run button 
 at the bottom of the panel. The bar to the right indicates the progress of the simulation, and the 

Status label reports on the state of the simulation. 

Note: Scenario execution can vary from seconds to hours, depending on many factors 
including the size of the basin, the number of time steps in the simulation, and the machine 
on which RiverWISE is running.

To stop a simulation click on the Stop button . The simulation will be halted when it reaches a point 
that is the next valid stopping state.
If a scenario execution aborts, you can try changing the input data. Otherwise, contact the model 
developer with the data that resulted in the aborted run. RiverWISE is not intended for debugging errors 
or fixing modeling issues, only for conducting runs and showing comparison results. The model 
developer can analyze the issue and advise a solution, either modified data or generation of an entirely 
new WISE file.
As a Stakeholder, you can communicate the issue to the Model Developer by one or more of the 
following: 
• Export the Log messages or entire text information as described HERE (Section 7).
• Export the scenario that you created, using the File Export Scenarios, as described HERE (Section 

10.1).
• Save the entire WISE file, using the File Save WISE File As, as described HERE (Section 10.1).
You can then provide this file to the Model Developer for further debugging. 
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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Model Developers can also export a RiverWare model file that represents the current state of the 
system. 

6. View Results

The “View Results” tab presents the result data sets for selected scenarios in current list. 

Scenario

Plot and 

Controls

Location
Controls

Data Sets
Controls

Table
Controls
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Check boxes to the right of the display area to provide display filters based on several attributes:
• Scenarios to Show: use the check boxes to show data for the desired scenarios. These controls also 

provide a color legend for plots and tables (column headers)
• Locations to Show: use the check boxes to choose the desired basin locations.
• Data Sets to Show: use the check boxes to choose which data sets will be shown. Only data sets asso-

ciated with currently shown locations are shown.
By default the series results data are shown as plots and tables; either the plot or the table displays can 
be hidden by de-selecting the appropriate check box to the lower right of the panel. For more 
information on plotting, see HERE (Section 9).

7. Log Diagnostic Messages

The Log tab displays diagnostic messages generated by RiverWare. These messages are intended for 
trained RiverWare model developers, hence are generally not of direct interest to RiverWISE users. 
They often use different terminology from that employed by RiverWISE, and reference internal 
simulation processes with which a RiverWISE user might not be familiar.

Following are some useful menu items you may wish to use if you have a problem and would like to 
send the diagnostics to the Model Developer. 

• File Save Diagnostic Messages to File: Save all diagnostics in the window to a text file which you 
could send to the model developer. 

• Edit Copy Message Line: copy a single line to the clipboard. You can then paste this in an email. 

• Edit  Copy Visible Message Lines: copy visible lines to the clipboard.

• Edit  Copy All Message Lines: copy all the diagnostics to the clipboard.

• Edit Clear Messages: clear the diagnostics from the dialog. 
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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8. Save WISE File and Export Scenarios

Save the results of selected scenarios to a file in order to access those results later or to share them with 
others. Saved scenarios include changes to the input data sets as well as the results of executing that 
scenario. Once you have decided which scenarios you would like to save, you can choose a File 
operation that either bundles them together with the RiverWare model to which they apply or saves 
them completely separately:
Save the WISE File: creates a new *.wise file with the RiverWare model and baseline scenario and 
additional scenarios you choose to add to it. From the File menu, select Save WISE File. You are 
prompted for the folder and a File Name Tag which are used to create a File Name. This File Name 
incorporates the original WISE File name, date (encoded timestamp), and your tag. You also select the 
scenarios to include. A screenshot is shown below. Click Save to write the file. This file can be large 
because it contains the RiverWare model. 

Export Scenarios: creates a Scenario file (*.sce) to export selected scenarios. From the File menu, 
select Export Scenarios. You are prompted for the folder and a File Name Tag which is used to create a 
File Name. This File Name incorporates the original WISE File name, date, tag, and the extension sce. 
You also select the scenarios to include. A screenshot is shown below. Click Save and the file is written.  
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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Note that whereas WISE files are self-contained, Scenario files can only be imported into RiverWISE 
after the WISE file associated with the scenarios has been opened. The *.sce file is much smaller than 
the WISE file as it is strictly the scenario input and result data, and does not include the model.

Note: [Warning] A WISE file represents the state of a RiverWare model at a very specific 
moment in time – when the file was generated by the developer. Each scenario applies to a 
specific original WISE file. It is not possible to import a scenario that was created in a 
different original WISE file. The naming convention used on *.wise and *.sce files will help 
you identify which scenarios can be imported into which WISE files. That is, the name and 
date in the file name, must match.

9. Plot controls

Within any plot shown in RiverWISE, you can zoom in by drawing a 
rectangle. Right Click and choose Auto-Scale to zoom to the full extents.  
The right-click context menu shows the following options:
• Auto-scale: scale and translate the plot to include the entire range of data.
• Zoom: Zoom in, zoom out on either one or both axes.
• Move: Translate the plot Left, Right, Up, or Down. 
• Export Image…: Create an image file representing the plot. The resulting 

dialog allows you select the export image file extension, size, resolution, 
and destination. The available file type extensions are: *.bmp, *.jpeg, 
*.pbm, *.pgm, *.png, *.ppm, *.xbm or *.xpm. Note that the image resolu-
tion affects only file formats that use compression. In general, you should use the highest resolution.

• Print…: Send an image of the plot to an installed Printer. You can create a PDF of the plot by printing 
to a PDF driver, if one is installed. 

10. Menu Operations

This section provides documentation of the RiverWISE menu operations. 

10.1 The File Menu

The File menu contains the following options for dealing with RiverWISE related files: 
• Open WISE File: Closes the currently open WISE file, and opens a new one. You are prompted for the 

path of the WISE file to open, then it is opened. 
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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• Save WISE File As: Saves the original model/run and baseline information along with any additional 
scenarios that you select. You are first prompted for the folder to which the new WISE file should be 
written, a custom tag, and to indicate which scenarios to include. Then the file is written.
Note that WISE files always include the original baseline scenario, all other scenarios are optional. 
WISE files are written with the “wise” suffix. 

• Export Scenarios: Writes a file containing selected scenarios. You are first prompted for the folder to 
which the new Scenario file should be written, a custom tag, and to indicate which scenarios to 
include, then the file is written.
Exported scenario information includes scenario description, input data and result data sets.
Since baseline data sets are always included in their WISE file, they cannot be exported to Scenario 
files. 
Scenario files are written with the “*.sce” suffix. 

• Import Scenarios: Reads a set of scenarios from a Scenario file and appends them to the list of cur-
rent scenarios. You are first prompted for the path of the Scenario file to be imported, and then the 
import occurs.
Only scenarios that were exported from the currently open WISE file can be imported.
Imported scenarios are renamed as necessary to ensure that all scenario names are unique within the 
currently open WISE file.

• Export RiverWare Model: Saves a RiverWare model file that corresponds to the last scenario execu-
tion. You are first prompted for the path of the file to which the model should be saved, then it is saved 
to that file.
The resulting model file can be provided to the original model developer, who can then load it into 
RiverWare and analyze differences aspects of the simulation that are not available within RiverWISE. 

• Close WISE File: Clears all information associated with the current WISE file, losing any unsaved 
changes.

• Exit: Exits RiverWISE. Any unsaved changes are lost.

10.2 The Help Menu
Following are the Help Menu options: 
• Open Help: Opens the RiverWISE documentation (this document) in a separate PDF application.
• About RiverWISE: Opens a window which displays information about the RiverWISE application, 

including version and copyright information.
RiverWare Technical Documentation: RiverWISE Stakeholder Guide
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